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SÁNG KIẾN KINH NGHIỆM:
MỘT SỐ BIỆN PHÁP GIÚP HỌC SINH HỌC TẬP TỐT MÔN TIN HỌC 7 Ở TRƯỜNG THCS
1. PHẦN MỞ ĐẦU:
1.1. Lí do chọn đề tài:
Bộ môn Tin học có ưu thế trong việc thực hiện mục tiêu giáo dục. Thông qua mỗi bài học, mỗi quá trình sẽ trang bị cho học sinh những hiểu biết cơ bản về công nghệ thông tin và vai trò của nó trong xã hội hiện đại. Môn Tin học giúp học sinh bước đầu làm quen với phương pháp giải quyết vấn đề theo quy trình công nghệ và kỹ năng sử dụng máy tính phục vụ học tập và cuộc sống. Tin học có ý nghĩa to lớn đối với sự phát triển trí tuệ, tư duy thuật toán, góp phần hình thành học vấn phổ thông cho học sinh.
Cùng với môn học khác, môn Tin học trong trường trung học cơ sở đã góp phần to lớn vào giáo dục thế hệ trẻ thành nguồn nhân lực có chất lượng để phục vụ cho sự nghiệp công nghiệp hoá, hiện đại hóa đất nước. Đây là trọng trách của Đảng và nhà nước đã giao cho ngành GD & ĐT. Để hoàn thành sứ mệnh cao cả đó, việc nâng cao chất lượng giáo dục được xem là vấn đề sống còn. Điều này cũng được Đại hội đại biểu toàn quốc lần thứ X của Đảng chỉ đạo: "Tiếp tục đổi mới mạnh mẽ phương pháp giáo dục, phát huy tính sáng tạo của người học, khắc phục lối truyền thụ một chiều, rèn luyện thành nếp tư duy sáng tạo của người học từng bước áp dụng các phương pháp tiên tiến và phương tiện hiện đại vào quá trình dạy học...”. Tiếp tục thực hiện chủ trương đổi mới căn bản, toàn diện giáo dục và đào tạo, Đại hội Đảng lần thứ XII đề ra phương hướng: Giáo dục là quốc sách hàng đầu. Phát triển giáo dục và đào tạo nhằm nâng cao dân trí, đào tạo nhân lực, bồi dưỡng nhân tài cho đất nước. Chuyển mạnh quá trình giáo dục từ chủ yếu trang bị kiến thức sang phát triển toàn diện năng lực và phẩm chất người học; phát triển giáo dục và đào tạo phải gắn với nhu cầu phát triển kinh tế - xã hội, xây dựng và bảo vệ Tổ quốc, với tiến bộ khoa học, công nghệ; Phấn đấu trong những năm tới, tạo chuyển biến căn bản, mạnh mẽ về chất lượng, hiệu quả GD & ĐT; Phấn đấu đến năm 2030, nền giáo dục Việt Nam đạt trình độ tiên tiến trong khu vực. Bởi vậy giáo dục luôn là thước đo cho sự phát triển của đất nước. Để đạt được mục tiêu đó là trách nhiệm chung của toàn xã hội,  bước đột phá là đổi mới phương pháp dạy học nhằm giúp học sinh lĩnh hội tốt kiến thức môn học.  
Từ năm học 2006-2007, môn Tin học ở THCS là môn học tự chọn cho những trường có điều kiện với thời lượng 2 tiết/tuần với tất cả các lớp ở cấp học. Là môn học mới đưa vào trường THCS và có những đặc thù riêng liên quan chặt chẽ với việc sử dụng máy tính, cách suy nghĩ và giải quyết vấn đề theo quy trình công nghệ, coi trọng làm việc theo nhóm. Đặc trưng của môn Tin học là kiến thức lí thuyết đi đôi với thực hành, đặc biệt ở lứa tuổi THCS phần thực hành còn chiếm thời lượng nhiều hơn.
Qua thời gian trực tiếp giảng dạy môn Tin học bản thân tôi nhận thấy các em nghĩ là môn phụ nên không quan tâm lắm và không chú trọng về môn Tin học, do đó nhiều học sinh còn yếu về kĩ năng thực hành trên máy tính. Thậm chí còn có một số học sinh còn ngại thực hành các thao tác trên máy tính mà chủ yếu là quan sát các học sinh khác trong nhóm thực hành (học sinh khá -giỏi). Do vậy các tiết thực hành ít khi đạt yêu cầu chất lượng chung cho cả lớp.
Từ thực tế trên, trong quá trình dạy học tôi luôn băn khoăn trăn trở làm thế nào để nâng cao chất lượng trong mỗi giờ dạy giúp các em thành thạo các thao tác cơ bản với máy tính nên trong quá trình giảng dạy tôi luôn chú trọng đến việc hướng dẫn, chia nhóm thực hành, đặt câu hỏi có vấn đề để kích thích sự hứng thú cho học sinh giúp các em có thể tự khám phá và tự học. Bởi vậy, bản thân tôi mạnh dạn đưa ra sáng kiến kinh nghiệm “Một số biện pháp giúp học sinh học tập tốt môn Tin học 7 ở trường THCS Đăk Drô” để trao đổi với các đồng nghiệp, giúp trau dồi chuyên môn phục vụ cho quá trình giảng dạy tốt hơn.  	
1.2. Mục đích nghiên cứu:
- Nghiên cứu cơ sở lý luận và cơ sở thực tiễn của chuyên đề
-  Đề ra một số biện pháp:  “Một số biện pháp giúp học sinh học tập tốt  môn Tin học 7 ở trường THCS”.
Với một số biện pháp đưa ra trong sáng kiến sẽ giúp học sinh tiếp thu bài nhanh hơn, hiệu quả hơn, góp phần nâng cao chất lượng bộ môn, chất lượng giáo dục.
1.3. Đối tượng nghiên cứu:
Học sinh lớp 7 trường Trung học cơ sở Đăk Drô
1.4. Các phương pháp nghiên cứu: 
Phương pháp trực quan: Đưa ra tình huống để học sinh quan sát, nhận xét, đánh giá, dự đoán kết quả.
	Phương pháp hoạt động nhóm: Học sinh quan sát, trao đổi thảo luận và rút ra kết luận.
	Phương pháp vận dụng tối đa các tiết thực hành để các em luyện tập tốt các bài học lý thuyết.
1.5. Giới hạn nghiên cứu: 
Chương trình Tin học 7 THCS ở trường Trung học cơ sở Đăk Drô, trong  năm học 2017-2018 và năm học 2018-2019.
2. NỘI DUNG
2.1: Cơ sở lý luận của vấn đề:
Công nghệ thông tin là một trong các phương tiện quan trọng nhất của sự phát triển, đang làm biến đổi sâu sắc đời sống kinh tế, văn hoá, xã hội, giáo dục của thế giới hiện đại, trong đó có Việt Nam. Chúng ta đang ở thời đại thông tin kĩ thuật số, thời đại Internet.
Đảng và Nhà nước đã có những chủ trương chính sách đầu tư và phát triển về ứng dụng công nghệ thông tin. 
Theo Nghị quyết 29-NQ/TW “về đổi mới căn bản, toàn diện giáo dục và đào tạo, đáp ứng yêu cầu công nghiệp hóa, hiện đại hóa trong điều kiện kinh tế thị trường định hướng xã hội chủ nghĩa và hội nhập quốc tế". Trong nhiệm vụ và giải pháp có nêu: Tiếp tục đổi mới mạnh mẽ phương pháp dạy và học theo hướng hiện đại; phát huy tính tích cực, chủ động, sáng tạo và vận dụng kiến thức, kỹ năng của người học; khắc phục lối truyền thụ áp đặt một chiều, ghi nhớ máy móc. Tập trung dạy cách học, cách nghĩ, khuyến khích tự học, tạo cơ sở để người học tự cập nhật và đổi mới tri thức, kỹ năng, phát triển năng lực. Chuyển từ học chủ yếu trên lớp sang tổ chức hình thức học tập đa dạng, chú ý các hoạt động xã hội, ngoại khóa, nghiên cứu khoa học. Đẩy mạnh ứng dụng công nghệ thông tin và truyền thông trong dạy và học. 
Như chúng ta đã biết giáo dục phổ thông nói chung, giáo dục trung học nước ta nói riêng đang thực hiện bước chuyển từ chương trình giáo dục tiếp cận nội dung sang tiếp cận năng lực của người học, nghĩa là từ chỗ chủ yếu quan tâm đến việc học sinh học được cái gì đến chỗ quan tâm học sinh vận dụng được cái gì qua việc học. Để đảm bảo được điều đó, nhất định phải thực hiện thành công việc chuyển từ phương pháp dạy học nặng về truyền thụ kiến thức sang dạy cách học, cách vận dụng kiến thức, rèn luyện kỹ năng, hình thành phẩm chất và năng lực; đồng thời phải chuyển cách đánh giá kết quả giáo dục từ nặng về kiểm tra tái hiện kiến thức sang kiểm tra, đánh giá năng lực vận dụng kiến thức giải quyết vấn đề, chú trọng kiểm tra đánh giá trong quá trình dạy học để có thể tác động kịp thời nhằm nâng cao chất lượng của các hoạt động dạy học và giáo dục. 
Tại điều 242, Luật giáo dục xác định rõ: “ Phương pháp giáo dục phổ thông nhằm phát huy tính tích cực, tự giác, chủ động, sáng tạo của học sinh sao cho phù hợp với đặc điểm của từng lớp học, môn học; bồi dưỡng phương pháp tự học, khả năng làm việc theo nhóm; rèn luyện kỹ năng vận dụng kiến thức vào thực tiễn; tác động đến tình cảm, đem lại nềm vui, hứng thú học tập cho học sinh”.
Trong chương trình mới, giáo dục Tin học có vai trò quan trọng chuẩn bị cho HS khả năng tìm kiếm, tiếp nhận, sáng tạo tri thức trong thời đại cách mạng công nghiệp. Công nghệ số là nền tảng tạo phương thức sản xuất thông minh mang tính toàn cầu hóa; là công cụ hiệu quả hỗ trợ biến việc học thành tự học suốt đời.
Bởi vậy đổi mới phương pháp dạy học được xem là nhiệm vụ trọng tâm của ngành giáo dục. Phấn đấu thực hiện các mục tiêu cụ thể của ngành là: Tổ chức tốt việc dạy và học Tin học ở tất cả các cấp học, bậc học, ngành học nhằm phổ cập Tin học trong nhà trường.
Đặc trưng của môn Tin học là khoa học gắn liền với công nghệ, do vậy dạy học Tin học một mặt trang bị cho học sinh kiến thức khoa học về Tin học, phát triển tư duy thuật toán, rèn luyện kĩ năng giải quyết vấn đề, mặt khác phải chú trọng đến rèn luyện kĩ năng thực hành, ứng dụng, tạo mọi điều kiện để học sinh được thực hành, nắm bắt và tiếp cận những công nghệ mới của Tin học phục vụ học tập và đời sống. Bởi vậy đổi mới phương pháp dạy học nhằm giúp học sinh học tốt môn Tin học là nhiệm vụ rất cần thiết.
2.2. Thực trạng của vấn đề
Thực tế qua những năm trực tiếp giảng dạy bộ môn cũng như qua trao đổi với đồng nghiệp tôi nhận thấy: Hầu như mọi học sinh đều rất hứng thú với môn Tin học. vì đây là môn học trực quan, sinh động, môn học khám phá những lĩnh vực mới nên học sinh rất hứng thú học, nhất là những tiết thực hành. Đời sống kinh tế gia đình của một số em ở nhà đã có máy vi tính nên cũng có những thuận lợi nhất định đối với môn học.
Đồng thời được nhà trường tạo mọi điều kiện thuận lợi cả về cơ sở vật chất, trang thiết bị, kế hoạch và con người phục vụ công tác đưa Tin học vào nhà trường. Tuy nhiên chất lượng bộ môn qua các năm học chưa cao, đặc biệt là kỹ năng thực hành trên máy tính của học sinh còn yếu, thậm chí một số học sinh còn rất ngại khi sử dụng máy để rèn luyện các kỹ năng, bởi đây là một môn học mới.
Trường THCS Đăk Drô là một trường nằm trên địa bàn của xã Đăk Drô, là một xã thuộc địa bàn kinh tế xã hội còn nhiều khó khăn. 
Với mục tiêu đầu tư cho giáo dục là đầu tư cho sự phát triển, trường THCS Đăk Drô luôn quan tâm đến việc đầu tư cơ sở vật chất, trang thiết bị dạy học nhằm đáp ứng nhu cầu đổi mới giáo dục. Đối với bộ môn tin học, được trang bị một phòng học bộ môn gồm có 15 máy tính kết nối internet. Tuy nhiên với điều kiện kinh phí còn hạn hẹp nên việc mua sắm trang thiết bị dạy học hiện đại (máy chiếu Projector), mua bổ sung thêm máy vi tính chưa thực hiện được. Với số lượng máy trên chưa đáp ứng được nhu cầu học tập của học sinh. Nhà trường đã có một phòng máy vi tính cho học sinh học nhưng vẫn còn hạn chế về số lượng cũng như chất lượng, mỗi ca thực hành có tới 2 đến 3 em ngồi cùng một máy nên các em không có nhiều thời gian để thực hành, làm bài tập một cách đầy đủ. Hơn nữa nhiều máy đã cũ, chất lượng không còn tốt nên hay hỏng hóc, ảnh hưởng tới chất lượng của học sinh.
Học sinh trên địa bàn chủ yếu là con em các gia đình làm nghề nông, học sinh là người đồng bào dân tộc thiểu số đông, trình độ học sinh không đồng đều, sự quan tâm của phụ huynh chưa thật sự sát sao dẫn đến việc học tập của con em còn nhiều hạn chế. Vì vậy điều kiện để các em có máy vi tính ở nhà là rất khó, hầu hết các em chỉ được tiếp xúc, làm quen với máy tính trong giờ học dẫn đến việc sử dụng máy tính của học sinh còn lúng túng, chất lượng giờ thực hành chưa cao. Một số học sinh chưa coi trọng môn học, xem đây là một môn phụ nên chưa có sự đầu tư thời gian cho việc học. 
	Bên cạnh đó môn Tin học là môn tự chọn trong chương trình bậc THCS nên chương trình và sự phân phối chương trình chưa có sự thống nhất và đang hoàn chỉnh.	 Đa số các em chỉ được tiếp xúc với máy vi tính ở trường là chủ yếu, do đó sự tìm tòi và khám phá máy vi tính với các em còn hạn chế, nên việc học tập của học sinh vẫn còn mang tính chậm chạp, hiệu quả và chất lượng chưa cao.
Qua khảo sát chất lượng đầu năm học, tôi thấy học sinh còn lơ là trong việc học môn Tin học, vì các em nghĩ đây là môn phụ nên không quan tâm, vì thế, kết quả khảo sát đầu năm học 2017-2018 chưa cao:
Kết quả khảo sát các lớp trước khi thực hiện đề tài
năm học 2017-2018
	TT
	Khối
	Sĩ số
	Kết quả kiểm tra

	
	
	
	Giỏi
	Khá
	Trung bình
	Yếu

	
	
	
	SL
	%
	SL
	%
	SL
	%
	SL
	%

	1
	7A1
	35
	5
	14
	14
	40
	16
	46
	
	

	2
	7A2
	33
	2
	6
	10
	30
	19
	58
	2
	6

	3
	7A3
	34
	3
	8
	9
	26
	16
	48
	6
	18

	Tổng cộng
	102
	10
	10
	33
	32
	51
	50
	8
	8


Từ thực trạng trên, là một giáo viên, tôi luôn trăn trở và tự đặt câu hỏi: Nguyên nhân nào dẫn đến thực trạng đó? Liệu có những biện pháp nào nhằm giúp HS phát huy được tính tích cực và làm thế nào để gây hứng thú cho học sinh về môn Tin học?  Đó là động lực thôi thúc tôi thực hiện sáng kiến kinh nghiệm: “Một số biện pháp giúp học sinh học tập tốt môn Tin học 7 ở trường THCS”.
2.3. Các biện pháp đã tiến hành để giải quyết vấn đề:
2.3.1. Mục tiêu của giải pháp, biện pháp: 
- Mục tiêu: 
+ Giúp học sinh tiếp thu nhanh, dễ nhớ kiến thức.
+ Giúp học sinh chủ động, tích cực tìm tòi và phát hiện ra kiến thức mới nhằm khắc phục tình trạng học thụ động. 
+ Học sinh có thể liên hệ được kiến thức đã học ở lớp 6 để vận dụng vào kiến thức mới (lớp 7), vận dụng vào kiến thức liên môn học liên quan trong chương trình các môn học như Toán học và Địa lí.
- Giải pháp:	
Phương pháp dễ sử dụng nhưng lại mang tính khoa học rất cao và công phu trong khâu soạn giáo án vì nó là một phương pháp phức tạp về mặt lí thuyết. Do vậy giáo viên phải nắm được một lượng kiến thức rộng, giáo viên phải thường xuyên học hỏi trao dồi khiến thức.
Thường xuyên tổ chức các buổi chuyên đề, tập huấn kỹ năng đặt câu hỏi, ra đề làm sao có tính thống nhất.
Không có phương pháp nào là vạn năng, do vậy người giáo viên phải biết sáng tạo, vận dụng linh hoạt, thâm nhập tâm lí học sinh, từ đó đưa ra những biện pháp hữu hiệu nhất. Phương pháp nào đi chăng nữa thì kết quả mong muốn cuối cùng là làm sao cho học sinh nắm được, nắm chắc các kiến thức mà giáo viên truyền thụ.
- Biện pháp:
+ Biện pháp giáo dục ý thức học tập cho học sinh: Giáo viên phải giáo dục ý thức học tập của học sinh ở bộ môn mình, tạo cho học sinh sự hứng thú trong học tập bộ môn từ đó sẽ giúp cho học sinh có ý thức vươn lên. Trong mỗi tiết dạy giáo viên nên liên hệ nhiều kiến thức vào thực tế để học sinh thấy được ứng dụng CNTT và tầm quan trọng của môn Tin học trong thực tiễn và trong tương lai sau này.
Giáo viên luôn luôn động viên đúng mức đối với học sinh khi các em làm bài sai, trên cơ sở đó giáo viên có thể chỉ ra chỗ sai, chỗ thiếu cho từng học sinh. Bên cạnh đó khen ngợi, khích lệ kịp thời đối với từng học sinh, giáo viên phải làm cho học sinh có lòng tin vào bản thân mình.
+ Biện pháp hướng dẫn học sinh quan sát kết hợp với thực hành: Ngay từ bài học đầu tiên trong chương trình học Tin học, phải xác định rõ cho học sinh nhận biết các bộ phận của máy tính và tác dụng của các bộ phận đó bằng cách cho học sinh quan sát ngay trong giờ giảng lý thuyết
2.3.2 - Nội dung và cách thức thực hiện giải pháp, biện pháp: 
Nội dung bài học phải đầy đủ, có tính thống nhất cao, phải đảm bảo tính tương tác giữa giáo viên và học sinh, lý thuyết đi đôi với thực hành. Phải có hình ảnh minh họa cụ thể để sau khi học xong học sinh có thể nắm bắt được hình ảnh thực tế.
- Tiến hành dạy học ở mức độ thích hợp nhất đối với trình độ của học sinh. Một nội dung quá dễ hoặc quá khó đều không gây được hứng thú. Cần biết dẫn dắt để học sinh luôn tìm thấy cái mới, có thể tự lực tìm thấy kiến thức mới. 
- Phát huy tối đa tính tích cực, sáng tạo của học sinh. (Đưa ra các tình huống có vấn đề đòi hỏi học sinh phải dự đoán, nêu giả thiết, tranh luận giữa những ý kiến trái ngược nhau). 
	Hoạt động của GV và HS
	Nội dung

	GV: Em đã biết soạn thảo và chỉnh sửa văn bản Word trong chương trình Tin học lớp 6, 


Vậy trong chương trình bảng tính Excel, cách nhập và sửa dữ liệu có giống với soạn thảo văn bản Word hay không?
HS1: Giống nhau
HS2: Khác nhau, vì màn hình Word và Excel khác nhau
GV: Để kiểm chứng kết quả xem bạn nào đúng thì chúng ta khởi động Excel và nhập dữ liệu vào.
→ Nhập nội dung sau: Chương trình ảng tính Excel.


HS: Quan sát và rút ra kết luận cách nhập dữ liệu.
GV: Nếu  nhập nội dung sai thì ta sửa như thế nào?
HS 1: Xóa rồi gõ lại
HS 2: Nháy đúp chuột vào ô đó và sửa tương tự như soạn thảo văn bản.
GV: Yêu cầu hai HS thực hành trên máy tính để các em rút ra kết luận
	Bài 1: Chương trình bảng tính là gì?
3. Nhập dữ liệu vào trang tính:
a, Nhập và sửa dữ liệu:
Nhập dữ liệu: Nháy chọn ô và gõ dữ liệu từ bàn phím.
Sửa dữ liệu: Nháy đúp chuột vào ô cần sửa và sửa dữ liệu tương tự như soạn thảo văn bản.



- Theo chỉ thị 40/2008/CT-BGDĐT đã phát động phong trào thi đua "Xây dựng trường học thân thiện - Học sinh tích cực". Giáo viên phải tạo được không khí thuận lợi cho lớp học, làm cho học sinh thích thú được đến lớp, mong đợi đến giờ học. Muốn thế, giáo viên phải tạo được sự gần gũi, thân thiện giữa thầy và trò, giữa trò và trò. Đây là một trong những yếu tố quan trọng của việc xây dựng môi trường thân thiện trong trường học. Giáo viên phải biết cách tổ chức và điều khiển lớp học một cách hợp lí các hoạt động của từng cá nhân và tập thể học sinh, giáo viên sẽ tạo được hứng thú cho cả lớp và niềm vui học tập của từng học sinh. Giáo viên luôn đặt ra những câu hỏi về kiến thức mới lạ để gây sự hứng thú và hấp dẫn cho học sinh.
Muốn để các em có hứng thú với môn học thì việc đầu tiên là giáo viên phải tạo tâm lí thoải mái cho học sinh. Khi đưa ra câu hỏi hoặc bài tập cần xem xét đến các đối tượng học sinh, xem các em có thể đáp ứng được các yêu cầu đó hay không? Nếu các em không đáp ứng được thì giáo viên cần có gợi mở cho các em. Chính vì thế  mỗi  giáo viên chúng ta cần tạo cho các em một tâm lí thoải mái, sự thân thiện trong các hoạt động dạy và học.
Trong quá trình dạy giáo viên phải có thái độ nhẹ nhàng, lấy nhu trị cương khi các học sinh mắc khuyết điểm, cư xử khéo léo với các em, xử lí tốt các tình huống sư phạm.
Khi nhận xét, đánh giá về học sinh phải đảm bảo yêu cầu chính xác, đối xử công bằng, công khai kết quả trong các giờ kiểm tra và nhận xét bài làm của học sinh. Khi các em không làm được bài cần động viên khuyến khích kịp thời để các em cần cố gắng hơn, không nên đánh giá  các em quá khắt khe khi bị điểm thấp để tránh các em chán nản, nên tạo cho các em một niềm tin khi học để khắc phục nhược điểm.
Tập cho các em thói quen học tập tích cực, chủ động, động viên kịp thời những em tiến bộ, cung cấp cho các em phương pháp học tập đúng đắn, khuyến khích các em không ngừng cố gắng, tạo điều kiện để các em đều có cơ hội phát biểu trong giờ học. 
Cần liên hệ thực tế và liên hệ tới các kiến thức đã học để các em tìm và phát hiện ra kiến thức mới.
	Hoạt động của GV và HS
	Nội dung

	GV: Tình huống: Cho bảng điểm


1, Em phải làm gì để biết điểm trung bình của mỗi bạn trong lớp?
2, Giả sử điểm của một số bạn trong lớp bị sai, em phải làm như thế nào? Điểm trung bình của các bạn có phải tính lại không?
Câu 3: Là thế nào để sắp xếp danh sách theo điểm trung bình từ thấp đến cao? 
HS:  Câu 1: Cộng các môn lại và chia trung bình
        Câu 2: Điểm sai thì sửa
                    Dự đoán kết quả của ý 2
         Câu 3: Bạn nào cao nhất gõ trước
	

	GV: Em hãy nhớ lại cách khởi động, lưu kết quả, mở mới, lưu với tên khác và thoát khỏi phần mềm soạn thảo văn bản Word? 
HS: Trả lời.
GV: Với chương trình bảng tính Excel, ta có thể thực hiện tương tự hay không?
HS1: Có thể thực hiện tương tự, nhưng chỉ khác biểu tượng khi khởi động.

Khởi động: Nháy đúp chuột vào biểu tượng  trên màn hình
Lưu kết quả: File →Save as
Lưu tệp với tên khác: File →Save 
Mở tệp mới: File → New
Thoát khỏi Excel: File →Exit
HS2: Lưu kết quả: File →Save 
Lưu tệp với tên khác: File →Save as
GV: Theo các em, HS1 hay HS2 đúng?
→ Yêu cầu hs áp dụng thực hành để rút ra kết quả đúng
	Bài thực hành 1: Làm quen với Excel.
Bài thực hành 2: Làm quen với các kiểu dữ liệu trên trang tính

Khởi động: Nháy đúp chuột vào biểu tượng  trên màn hình
Lưu kết quả: File →Save
Lưu tệp với tên khác: File →Save as
Mở tệp mới: File → New
Thoát khỏi Excel: File →Exit

	GV: Cho bảng tính:


Theo em, trong soạn thảo văn bản thường có những dạng dữ liệu nào? Các dạng dữ liệu đó có sử dụng được trong chương trình Excel hay không? Cho ví dụ
HS: Dữ liệu số và dữ liệu kí tự, các dạng dữ liệu đó có sử dụng được trong chương trình Excel.
Dữ liệu số: Là các số 0, 1, 2,…., 9; số âm (-) ; số dương (+); % ; 
Ví dụ : +12; -10; 151.25 ; 123,439
Dữ liệu kí tự: Là các chữ cái, chữ số và các kí hiệu.
Ví dụ: Trường em; Lớp 7A1; Hà Nội

GV: Em đã biết chọn phần văn bản trong soạn thảo văn bản, với chương trình Excel cách chọn nội dung như thế nào?
HS: Chọn theo cột, theo ô


,  

	Chọn theo khối
	




Chọn theo hàng

 
Hoặc chọn kết hợp


	Bài 2: Các thành phần chính và dữ liệu trên trang tính.
3. Dữ liệu trên trang tính:
a, Dữ liệu số: Là các số 0, 1, 2,…., 9; số âm (-) ; số dương (+); % 

b, Dữ liệu kí tự: Là các chữ cái, chữ số và các kí hiệu.







4. Chọn các đối tượng trên trang tính:
Chọn một cột :
Chọn một ô :
Chọn một khối :
Chọn một hàng :
Chọn kết hợp :



	GV: Quan sát hai hình sau và cho nhận xét?


       
             H1                                              H2
HS: H1 là biểu tượng dùng để chèn thêm hàng (cột) hoặc xóa hàng (cột) trong soạn thảo văn bản.
→ Từ H1 học sinh sẽ suy ra H2 là biểu tượng dùng để chèn thêm hàng (cột) hoặc xóa hàng (cột) trong chương trình bảng tính Excel.
GV: Muốn sao chép và di chuyển dữ liệu, ta sử dụng nút lệnh nào?
HS: Sẽ nhớ tới các nút lệnh sao chép và di chuyển trong soạn thảo văn bản.


Sao chép: Sử dụng nút lệnh Copy và Paste.
Di chuyển: Sử dụng nút lệnh Cut và Paste.
	Bài 5: Thao tác với bảng tính.
2. Chèn thêm hoặc xóa cột và hàng:
a, Chèn thêm cột hoặc hàng:
Chèn cột (hàng): Chọn cột (hàng) →Home → Cell → Insert.
b, Xóa cột hoặc hàng:
Xóa cột hoặc hàng: Chọn cột (hàng) →Home → Cell → Delete

3. Sao chép và di chuyển dữ liệu:
Sao chép dữ liệu: Sử dụng nút lệnh

 
Di chuyển dữ liệu: Sử dụng nút lệnh 



	GV: Quan sát hai hình sau và cho nhận xét?


                                        H1


                                        H2
HS: H1 là biểu tượng dùng để định dạng phông chữ, cỡ chữ, kiểu chữ, màu chữ, màu nền và căn lề trong Word. 
→ Từ H1 học sinh sẽ suy ra H2 là biểu tượng dùng để định dạng phông chữ, cỡ chữ, kiểu chữ, màu chữ, màu nền và căn lề trong Excel.
GV: Em hãy cho biết ý nghĩa của các nút lệnh sau:


 
                  H1                                        H2
HS:  
	H1
	H2

	1, Phông chữ
	1- 4: Căn trái

	2, Cỡ chữ
	2-5: Căn giữa

	3, Kiểu chữ
	3-6: Căn phải

	4, Màu chữ
	


GV: Yêu cầu HS thực hành trên máy để rút ra kết luận
HS: Thao tác trên máy và kết luận:
	H1
	H2

	1, Phông chữ
	1, Căn lề trên ô

	2, Cỡ chữ
	2, Căn lề giữa ô

	3, Kiểu chữ
	3, Căn lề dưới ô

	4, Màu chữ
	4, Căn lề trái

	
	5, Căn giữa

	
	6, Căn lề phải



	Bài 6: Định dạng trang tính.
Định dạng phông chữ, cỡ chữ, kiểu chữ, màu chữ, màu nền và căn lề:
 















- Định dạng phông chữ, cỡ chữ, kiểu chữ, màu chữ, màu nền: Sử dụng các nút lệnh trong nhóm Font trên dải lệnh Home: sgk
- Căn lề: Sử dụng các nút lệnh trong nhóm Alignment trên dải lệnh Home: sgk


	GV: Em hãy quan sát hai hình sau và cho nhận xét?



                             H1


                                      H2
HS: H1 là biểu tượng dùng để đặt lề và hướng giấy in trong Word. 
→ Từ H1 học sinh sẽ suy ra H2 là biểu tượng dùng để để đặt lề và hướng giấy in trong Excel.
→ Page Layout → Margins → Custom Margins
Đặt lề: Margins→ Thay đổi thông số các lề (Trên, dưới, trái, phải) → Ok
Thay đổi hướng giấy: 
Page → Portrait (Đứng)
        → Landscape (Ngang) 
	Bài 7. Trình bày và in trang tính.
3, Đặt lề và hướng giấy in:


Các bước thực hiện: sgk

	Như vậy, từ những kiến thức đã được học ở lớp trước (lớp 6), các em có thể vận dụng linh hoạt, tìm tòi và phát hiện ra kiến thức mới (lớp 7).
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Học sinh tìm hiểu phát hiện kiến thức mới
Sử dụng hệ thống câu hỏi và bài tập, đặt vấn đề tạo ra các tình huống để học sinh tìm cách giải quyết các tình huống có vấn đề. Giáo viên là người gợi mở và hướng dẫn (nếu cần). Quá trình giải quyết vấn đề có thể như sau: 
+ Hiểu rõ vấn đề 	
+ Xác định hướng giải quyết vấn đề. Nêu giả thuyết.
+ Kiểm tra sự đúng đắn của giả thuyết. 
+ Giáo viên chỉnh lí bổ sung và chỉ ra kiến thức mới cần lĩnh hội. 
- Phát huy tính tích cực chủ động của học sinh, rèn luyện tư duy sáng tạo cho học sinh trong các giờ học thể hiện ở chỗ: 
+ Kích thích được sự tò mò khoa học, ham hiểu biết của các em bằng cách tạo ra những tình huống có vấn đề. Đó thường là những câu hỏi thú vị gây hứng thú học tập, tạo nhu cầu nhận thức và có thể nghiên cứu được đối với học sinh.
- Thay đổi, phát triển hiểu biết, quan niệm ban đầu của học sinh để đạt được kiến thức mới.
 - Tăng cường vấn đáp tìm tòi, tạo ra các cuộc tranh luận, thảo luận. Chẳng hạn như:
	+ Khi học sinh trả lời sai, cần nhận xét một cách khuyến khích, nếu trả lời đúng thì nên biểu dương.
+ Đưa ra nhiều câu hỏi ngắn gọn để tạo điều kiện cho nhiều học sinh trả lời.
	+ Khi học sinh trả lời đúng hay sai, thì yêu cầu học sinh giải thích câu trả lời. 
	+ Đối với những học sinh khá – giỏi, có thể liên hệ câu trả lời với những kiến thức khác.
- Sử dụng các thiết bị, phương tiện dạy học theo hướng phát huy tính tích cực học tập của học sinh. 

	Hoạt động của GV và HS
	Nội dung

	GV: Em hãy cho biết kết quả của phép tính sau: (6+8):2-3
(Thực hành trên máy tính)

HS: → Không ra kết quả
GV: Chúng ta đã biết là máy tính có khả năng tính toán nhanh, vậy tại sao lại không ra kết quả?
HS: Tìm hiểu và phát hiện ra kiến thức mới, khi tính toán trong Excel, một số kí hiệu sẽ khác so với Toán học.

 → Kết quả vẫn không ra. 
GV: Tại sao (máy cô lại có kết quả)?
HS: Khám phá ra dấu = sẽ thay đổi vị trí. Từ đó HS sẽ vận dụng để tính được kết quả của phép tính theo công thức:


	GV: Cho dữ liệu hình bên:
Em hãy tính tổng hai số tương ứng ở cột A và B, ghi kết quả vào cột C.

	



HS: Tính theo công thức ở mục 2 (8 công thức 8 kết quả).
GV: Có cách nào mà chỉ cần 1 công thức nhưng ta sẽ biết được 8 kết quả không?
HS: Không có.
GV: Có
HS: Sẽ tìm hiểu ở mục 3 và biết được cách sử dụng địa chỉ ô trong công thức khi tính toán
	Bài 3: Thực hiện tính toán trên trang tính.
2. Nhập công thức:
Các bước nhập công thức: sgk

	GV: Cho bảng điểm sau:


Em hãy tính điểm trung bình của các bạn trong lớp. Làm thế nào để biết bạn nào có điểm trung bình cao nhất và điểm trung bình thấp nhất? 
HS: Thực hiện tính theo công thức đã học ở bài 3. Nhìn vào cột điểm trung bình từ đầu đến cuối để xác định điểm trung bình cao nhất và điểm trung bình thấp nhất.
GV: Còn có cách tính nào khác nhanh hơn không?
HS: Phát hiện ra các hàm trong Excel ở mục 3. Học sinh vận dụng tính điểm trung bình với hàm Average (sử dụng địa chỉ khối) và hàm Max, Min để xác định giá trị lớn nhất và nhỏ nhất


	Bài 4: Sử dụng các hàm để tính toán.
3. Một số hàm thường dùng:
a, Hàm tính tổng:
=Sum(a,b,c,…).
b, Hàm tính trung bình cộng:
=Averager(a,b,c,…)
c, Hàm xác định giá trị lớn nhất:
=Max(a,b,c,…)
d, Hàm xác định giá trị nhỏ nhất:
=Min(a,b,c,…)

		GV: Các em đã biết cách sao chép dữ liệu. Vậy với công thức khi chúng ta sao chép thì kết quả sẽ như thế nào? Em hãy sao chép công thức ô D5 sang ô D6 thì kết quả có thay đổi không?
	



HS: Dự đoán kết quả là không thay đổi
GV: Kết quả sẽ thay đổi. Yêu cầu học sinh sao chép công thức trong ô M4 sang ô M5.
HS: Thực hành và thấy được sự kì diệu trong môn Tin học
GV: Thay vì sao chép công thức, giáo viên hướng dẫn học sinh cách kéo các công thức còn lại
Lưu ý: Khi muốn sao chép công thức (kéo công thức) thì công thức phải sử dụng địa chỉ ô hoặc địa chỉ khối
	Bài 5. Thao tác với bảng tính.
4. Sao chép công thức:
Sao chép công thức: Sử dụng các nút lệnh:



	GV: Cho bảng điểm lớp em:


Làm thế nào để biết được bạn có điểm trung bình cao nhất và điểm trung bình thấp nhất? (chỉ bằng một thao tác)
HS: Sử dụng hàm Max, Min
GV: Chỉ một thao tác thì không thể sử dụng hàm Max và hàm Min được.


HS: Tìm tòi và phát hiện sử dụng nút lệnh  hoặc  để sắp xếp theo thứ tự tăng dần hoặc giảm dần.
	Bài 8. Sắp xếp và lọc dữ liệu.
1, Sắp xếp dữ liệu:
Các bước thực hiện:
B1: Chọn ô cần sắp xếp 


B2: Nháy chọn nút lệnh  hoặc  để sắp xếp theo thứ tự tăng dần hoặc giảm dần.

	GV: Tình huống
Các em đã được học cách vẽ biểu đồ chưa?
HS: Trong môn Địa lí
	GV: Cho số liệu sau:
Em hãy vẽ biểu đồ hình cột thể hiện số học sinh giỏi qua từng năm (một em thể hiện trên bảng, số còn lại thực hành trên máy tính)

	



HS: Sẽ nhận thấy được ưu điểm khi vẽ biểu đồ trên máy tính. Đọc nội dung sgk và vẽ biểu đồ


GV: Ví dụ ban đầu vẽ biểu đồ hình cột nhưng sau lại muốn vẽ bằng biểu đồ hình tròn thì ta làm như thế nào?
HS: Vẽ lại
GV: Làm sao để không vẽ lại mà ta vẫn có thể thay đổi được dạng biểu đồ?
HS: Tìm hiểu cách thay đổi dạng biểu đồ thông qua các nút lệnh trong nhóm Charts

 
	Bài 9. Trình bày dữ liệu bằng biểu đồ.









3. Tạo biểu đồ:
Các bước tạo biểu đồ: sgk








 2.3.3. Dạy học lý thuyết kết hợp với thực hành và phương tiện dạy học: 
Phương pháp dạy học lý thuyết kết hợp với thực hành có thể nói là mới đối với các môn học khác, nhưng với môn Tin học thì phương pháp này là không thể thiếu khi dạy bất kì nội dung Tin học nào. Đây là một phương pháp dạy học chủ đạo trong quá trình dạy học Tin học. Thực tế trong nhà trường môn Tin học xem như là một môn học phụ, lượng kiến thức cho học sinh học bị dồn nén. Do đó, nếu học lý thuyết chung chung học sinh rất mau quên. Kiến thức Tin học là những nội dung tương đối mới mẻ, xa lạ và có nhiều khái nệm rất trừu tượng đối với nhiều học sinh. Hơn nữa kiến thức Tin học đòi hỏi rất nhiều kỹ năng sử dụng máy tính nhanh chóng và chính xác. 
Để một tiết học đạt hiệu quả thì không thể không có phương tiện dạy học. Nếu như khi dạy học mà giáo viên không sử dụng phương tiện dạy học thì giáo viên phải làm việc nhiều nhưng hiệu quả lại ít. Đặc biệt đối với bộ môn Tin học nếu như không có phương tiện dạy học thì tiết học lại càng nhàm chán và học sinh khó nắm vững kiến thức, thuộc lí thuyết nhưng khi thực hành thì lại không thao tác được
	Ví dụ khi dạy bài 2:
 Giáo viên đang chọn ô U150, bây giờ muốn chọn ô A1 thì ta  làm thế nào?
HS: Ta bấm chọn hộp tên và gõ A1 rồi bấm Enter
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Nhưng khi thực hành thì các em sẽ đi tìm hộp tên ở đâu? Nếu tìm thấy thì cách nhập địa chỉ ô vào hộp tên như thế nào. Hay khi dạy học sinh cách chọn các đối tượng trên trang tính, nếu không dùng phương tiện dạy học thì khi thực hành các em sẽ không thực hiện được cách chọn các đối tượng trên trang tính → Như vậy thì các em sẽ mất thời gian mà lại không đạt hiệu quả.
Có thể nói giờ học thực hành khá quan trọng với bộ môn Tin học. Nếu như giáo viên chỉ dạy lí thuyết mà không chú trọng đến thực hành thì sẽ không khắc sâu được kiến thức cho học sinh đồng thời học sinh không biết được những lỗi mà mình mắc trong quá trình thực hành. Vì hầu hết các em chưa có máy tính ở nhà nên đều ít tiếp xúc với máy tính, cho nên trong quá trình dạy môn Tin học giáo viên cần kết hợp giữa lí thuyết với thực hành để các em có cơ hội rèn luyện kĩ năng thực hành nhiều hơn. Điều này  sẽ tạo hứng thú cho các em trong giờ học Tin học.
Để giờ thực hành đạt hiệu quả thì cần có sự chuẩn bị thật tốt.
Quan trọng nhất là nội dung  thực hành, lựa chọn nội dung phù hợp với từng lớp, từng nhóm đối tượng học sinh. Giáo viên có thể lựa chọn bài tập từ đơn giản để dẫn dắt các em vào bài, sau đó có thể thực hành thêm nội dung trong sách giáo khoa hoặc bài tập nâng cao đối với các em khá giỏi, vì có những lớp kiến thức của các em không nắm bắt được hết nội dung trong sách giáo khoa của tiết học đó.
Trước khi học tiết thực hành thì các em cần nghiên cứu trước nội dung thực hành và phải mang đầy đủ sách vở cần thiết tránh hiện tượng không nắm được trước nội dung sẽ không chủ động trong quá trình thực hành.
Trong tiết thực hành giáo viên có thể hướng dẫn trước một số công việc trên máy chiếu trong phòng thực hành để học sinh quan sát sau đó để các em tự thực hành. 
Ví dụ: - Khi dạy nội dung:  “Chèn thêm hoặc xóa cột và hàng” (Tin học 7) 
Nếu yêu cầu học sinh trình bày bằng lý thuyết và hôm sau mới thực hành thì học sinh chỉ trình bày lý thuyết suông mà không thao tác được trên máy tính. 
Còn nếu yêu cầu học sinh xem nội dung sách giáo khoa sau đó áp dụng thực hành trên máy tính thì có rất nhiều học sinh trả lời và thao tác  được (Vừa nêu lý thuyết vừa thực hành trên máy tính), ngay cả những học sinh trung bình và yếu.
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                   Chèn ô, hàng, cột.                                Xóa ô, hàng, cột.   
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                            Học lý thuyết kết hợp thực hành
Vì vậy dạy học lý thuyết gắn liền với thực hành trên máy tính là điều kiện rất quan trọng để học sinh nắm được kiến thức mới, hình thành kỹ năng thao tác trên máy tính cho mình. Kiến thức Tin học không đòi hỏi cao ở khả năng trình bày lý thuyết suông mà đòi hỏi học sinh phải có kỹ năng thực hành giỏi, biết sử dụng máy tính thành thạo. 
2.3.4. Tổ chức hoạt động nhóm
Đây là phương pháp dạy học chia lớp thành nhiều nhóm nhỏ. Các thành viên trao đổi trong nhóm tự do về yêu cầu đề bài nhằm tạo điều kiện cho các em bộc lộ quan điểm và ý kiến riêng, đồng thời lắng nghe ý kiến của các bạn khác
Làm việc theo nhóm cho phép tất cả các thành viên trong nhóm giải quyết một cam kết làm việc được mô tả rõ ràng, không được giáo viên dẫn dắt trực tiếp mà chỉ nhờ vào sự kết hợp chặt chẽ và phân công công việc trong nhóm nhỏ.
Phương pháp này các em đưa ra những cách thức giải quyết đầy tính sáng tạo, kích thích sự hợp tác của các thành viên trong nhóm cùng tham gia vào việc giải quyết một vấn đề. Làm việc theo nhóm thoả mãn nhu cầu học tập của cá nhân, người học có thể đưa ra những giải pháp, cách biểu đạt riêng cho vấn đề nào đó. Nếu trong phương pháp thuyết trình người học chỉ có thể trao đổi với nhau rất ít thì làm việc theo nhóm các thành viên tham gia có cơ hội đưa ra quan điểm của mình đối với chủ đề thảo luận, mặt khác ở đó cũng đòi hỏi tăng cường tư duy độc lập và trao đổi lẫn nhau trong nhóm.
Khi hoạt động theo nhóm, là đưa các em vào hoạt động phát biểu, nói tập trung vào nhiệm vụ, tạo cơ hội thực hành các kĩ năng như sáng tạo, đánh giá, tổng hợp, phân tích. Các em được thể hiện khả năng làm việc và thực hành kĩ năng giao tiếp với mọi người, nâng cao quan hệ thân ái, tin cậy và giúp đỡ nhau giữa các em. Giáo viên cũng có cơ hội tận dụng quan điểm và kinh nghiệm của học sinh. Đặc biệt để đạt hiệu quả cao trong hoạt động nhóm thì không nên lạm dụng quá nhiều và quá lâu, bố trí chỗ ngồi cho các em phải nhìn thấy nhau.
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Thảo luận nhóm để tìm hiểu kiến thức mới
- Giáo án thể hiện nội dung một tiết dạy:
Tuần: 15				   		   	                 NS: 01.12.2019
Tiết: 29							                 ND: 04.12.2019
BÀI 6. ĐỊNH DẠNG TRANG TÍNH (T1)

I.  MỤC TIÊU:
1. Kiến thức:  Học sinh biết định dạng một trang tính: Thay đổi phông chữ, cỡ chữ, kiểu chữ và căn lề ô tính.
2. Kỹ năng:  HS biết cách định dạng trang tính.
3. Thái độ: Học tập nghiêm túc, yêu thích môn học
4. Định hướng phát triển năng lực: 
Năng lực chung: Phát hiện và giải quyết vấn đề
Năng lực chuyên biệt: Vận dụng vào cuộc sống, sử dụng ngôn ngữ, năng lực tự học, hợp tác, năng lực giao tiếp và giải quyết vấn đề, năng lực ƯDCNTT
II.  CHUẨN BỊ: 
1. Giáo viên: Giáo án, ĐDDH.
2. Học sinh: Chuẩn bị bài cũ, nghiên cứu trước bài mới. 
III.  CHUỖI HOẠT ĐỘNG DẠY – HỌC 
1.  Hoạt động khởi động.
   * Ổn định tổ chức:
   * Khởi động: 
Em hãy quan sát H1 và H2 sau bằng cách đánh dấu x vào ô hợp lí?
1. Nội dung trang tính có thay đổi hay không?	
	                   Có				Không
      2. Ở H2 đã thực hiện những định dạng quen thuộc nào trong word?		
  Tô màu nền			in nghiêng
		   Kẻ đường viền		Gạch chân
		   Thay đổi màu chữ		Căn lề
		    In đậm 			Trộn ô	
GV: Vậy với chương trình bảng tính Excel, ta có thể vận dụng cách định dạng tương tự như phần mềm soạn thảo văn bản Word hay không?
HS: Dự đoán kết quả.
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                     H1                                                          H2
2.  Hoạt động hình thành kiến thức:	
	HĐ CỦA GV
	HĐ CỦA HS
	NỘI DUNG

	HĐ 1: Đặt vấn đề

	GV: Cho H1 và H2; 1. Hai cách trình bày ở H1 và H2 có những điểm gì khác nhau? Em hãy ghi lại những điểm khác nhau mà em nhận biết được.
2. Theo em, cách trình bày nào dễ thu hút được sự chú ý của người đọc vào những phần dữ liệu quan trọng, giúp người đọc dễ so sánh dữ liệu hơn?
	 HS: Quan sát H1 và H2→ Dự đoán câu trả lời.
1. Những điểm khác nhau ở H1 và H2:
H1: Gõ nội dung vào theo mặc định
H2: Từ H1 rồi định dạng phông chữ, cỡ chữ, màu chữ, kiểu chữ, căn lề.
2. Theo em cách trình bày ở H2 dễ thu hút được sự chú ý của người đọc vào những phần dữ liệu quan trọng, giúp người đọc dễ so sánh dữ liệu hơn.
	

	HĐ 2: Tìm hiểu cách định dạng phông chữ, cỡ chữ, kiểu chữ và màu chữ

	- GV: Với chương trình bảng tính Excel  các tính năng định dạng như : phông chữ, cỡ chữ, kiểu chữ, màu chữ có tương tự như phần mềm soạn thảo văn bản Word hay không?
→ Y/c hs thảo luận nhóm trả lời câu hỏi: Em hãy nêu cách định dạng:   Phông chữ, cỡ chữ?  kiểu chữ, màu chữ (Thao tác trên máy tính để được H2)

 GV: Nhận xét và chốt kiến thức
	- HS: Trả lời








- HS: Hoạt động nhóm đưa ra đáp án
Định dạng:   Phông chữ, cỡ chữ, kiểu chữ, màu chữ: Sử dụng các lệnh trong nhóm Font trên dải lệnh Home (nêu cách thực hiện sau đó thao tác trên máy tính)


	1. Định dạng phông chữ, cỡ chữ, kiểu chữ và màu chữ:
- Sử dụng các nút lệnh trong nhóm Font trên dải lệnh Home: sgk
* Chú ý : Có thể sử dụng đồng thời các nút lệnh định dạng kiểu chữ để có các kiểu chữ thích hợp.













Vận dụng: [image: ]
[image: ]
	HĐ CỦA GV
	HĐ CỦA HS
	NỘI DUNG

	HĐ 3: Tìm hiểu cách định dạng căn lề trong ô tính

	- GV: Để căn lề trong ô tính, ta sử dụng nút lệnh nào?






GV: Em hãy cho biết ý nghĩa của các nút lệnh sau:


                                


        
- GV: Để căn tiêu đề vào giữa các cột (Từ cột A đến cột G – H2) → Ta thực hiện như thế nào?

- GV: Gợi ý để hs tìm ra nút lệnh căn giữa các cột
	- HS: Sử dụng các nút lệnh trong nhóm Alignment trên dải lệnh Home


         Căn lề
→ Nhóm khác nhận xét (bổ sung)
- HS: 





- HS: Sử dụng nút lệnh căn giữa 

 →Kết quả không đúng theo y/c của gv 

- HS: Sử dụng nút lệnh  : Merge and Center trong nhóm Alignment trên dải lệnh Home
	2. Căn lề trong ô tính:
- Sử dụng các nút lệnh trong nhóm Alignment trên dải lệnh Home: sgk





















* Lưu ý: Căn chỉnh dữ liệu vào giữa các cột, sử dụng nút lệnh

 : Merge and Center


Vận dụng: 
	Em hãy cho biết cách căn lề ở mỗi khung sau:
[image: ]
	HS:
[image: ]


	HĐ4: Áp dụng thực hành

	- GV: y/c hs thực hành trên máy tính, nhập dữ liệu như H1 (sử dụng hàm thích hợp để tính cột điểm trung bình) để có kết quả tương tự như H2 (có thể thay bằng phông chữ khác)
- GV: Quan sát và hướng dẫn thường xuyên
	- HS: Thực hiện theo y/c của gv
	* Thực hành
Em hãy thực hiện các thao tác định dạng từ H1 để có kết quả tương tự như H2


3. Hoạt động tìm tòi – mở rộng:
Bài tập:  Em đã biết cách sao chép dữ liệu (sử dụng các nút lệnh [image: ] và [image: ]),
Theo em, nút lệnh [image: ] có thể sử dụng để sao chép định dạng được hay không?
Về nhà:  Học bài, thực hành lại nội dung vừa học và xem trước nội dung phần còn lại
2.4. Kết quả đạt được:
Qua thời gian áp dụng phương pháp, tôi nhận thấy giờ Tin học thực sự thu hút các đối tượng học sinh hơn chứ không còn là giờ học của các đối tượng học sinh khá giỏi. Học sinh hoạt động tích cực hơn, các thao tác trên máy thực hiện khá thuần thục. Các đối tượng học sinh hỗ trợ được cho nhau để cùng học, cùng tiến bộ.
Kết quả khảo sát các lớp sau khi thực hiện đề tài
năm học 2018-2019  
	TT
	Khối
	Sĩ số
	Kết quả kiểm tra

	
	
	
	Giỏi
	Khá
	Trung bình
	Yếu

	
	
	
	SL
	%
	SL
	%
	SL
	%
	SL
	%

	1
	7A1
	35
	18
	51.3
	15
	43
	2
	5.7
	
	

	2
	7A2
	33
	10
	30
	11
	33.7
	12
	36.3
	
	

	3
	7A3
	34
	8
	23.5
	12
	35.3
	14
	41.2
	
	

	Tổng cộng
	102
	36
	35.3
	38
	37.3
	28
	27.4
	
	


Như vậy so với trước khi thực hiện đề tài và sau khi thực hiện đề tài chất lượng bộ môn đã có sự thay đổi rõ rệt số lượng học sinh khá giỏi tăng lên, trung bình – yếu giảm, kết quả đã vượt qua chỉ tiêu đề ra.
3. KẾT LUẬN VÀ KIẾN NGHỊ.
3.1. Kết luận: 
       Mục tiêu  trong chương trình giáo dục phổ thông tổng thể bộ giáo dục yêu cầu cần cải cách giáo dục ở các trường trong những năm tiếp theo là từng bước nâng cao chất lượng dạy và học, xem trọng việc học sinh nhận biết, thông hiểu và vận dụng kiến thức tổng hợp đã học ở trường phổ thông vào thực tế đời sống, đáp ứng nhu cầu con người trong thời đại công nghiệp hóa, hiện đại hóa đất nước với xu thế hội nhập quốc tế.
Tin học là môn học mới đối với học sinh phổ thông. Để tạo hứng thú học tập cho học sinh và từng bước nâng cao chất lượng bộ môn đòi hỏi người giáo viên phải tìm tòi, đổi mới phương pháp dạy học phù hợp, hiệu quả.
Trong quá trình dạy học áp dụng đề tài này tôi nhận thấy rằng các em rất hứng thú với môn Tin học, các em đã thực hiện các kĩ năng cơ bản trên máy thành thạo hơn, tích cực tự giác trong các giờ học và các em áp dụng được nhiều kiến thức được học vào cuộc sống hàng ngày. 
       Đối với người giáo viên, sự thành công lớn nhất, niềm hạnh phúc quý giá nhất chính là học sinh học giỏi và yêu thích bộ môn của mình. Qua đề tài này, tôi biết vẫn còn có nhiều thiếu sót nhưng chỉ xin góp một phần bé nhỏ vào các phương pháp dạy học nhằm nâng cao chất lượng dạy học bộ môn Tin học.Hãy biến những kiến thức tin học trong sách giáo khoa thành những bài học thực tế áp dụng trong cuộc sống vô cùng có ý nghĩa - Đó là những gì mà Tôi và nhiều đồng nghiệp muốn làm trong sự nghiệp trồng người mà chúng Tôi đã và đang cống hiến.
Sáng kiến kinh nghiệm về “ Một số biện pháp giúp học sinh  học tập tốt môn Tin học 7 ở trường THCS” đã được hội đồng sáng kiến cấp trường công nhận và được triển khai phổ biến ra toàn trường để thực hiện nâng cao chất lượng dạy và học ở trường THCS Đăk Drô
3.2. Kiến nghị
	* Đối với nhà trường: Đầu tư thêm trang thiết bị cho phòng máy vi tính, đảm bảo số lượng máy tính tạo điều kiện cho các em học sinh được thực hành nhiều hơn 1 học sinh/1 máy tính. Vì có như vậy chất lượng dạy và học của giáo viên và học sinh mỗi ngày đạt chất lượng cao hơn.
* Đối với giáo viên bộ môn: 
Để thực hiện tốt nhiệm vụ dạy học môn Tin học phù hợp với các đối tượng học sinh thì phải thực hiện được các vấn đề sau:
- Thiết kế bài dạy phù hợp với nhiều đối tượng học sinh.
Giáo viên phải nắm bắt đối tượng học sinh về kĩ năng thực hành và phân loại đối tượng rõ ràng, chính xác.
- Điều hành tổ chức hoạt động của học sinh trên lớp.
Giáo viên cần đưa ra hệ thống bài tập thực hành, yêu cầu về các kĩ năng sát với từng đối tượng học sinh. Điều hành các hoạt động của học sinh một cách linh hoạt, tạo cơ hội cho các đối tượng học sinh được thực hành 
- Đánh giá và theo dõi kết quả học tập theo từng đối tượng học sinh, khen những học sinh thực hành tốt, nghiêm túc, nhắc nhở những học sinh thực hành chưa tốt, chưa nghiêm túc.
Sáng kiến kinh nghiệm: “Một số biện pháp giúp học sinh  học tập tốt môn Tin học 7 ở trường THCS”, đã được hội đồng sáng kiến cấp trường công nhận và  được triển khai phổ biến ra toàn trường để thực hiện nâng cao chất lượng dạy và học ở trường THCS Đăk Drô.
Trên đây là báo cáo của bản thân , trong quá trình nghiên cứu do trình độ còn hạn chế nên không tránh khỏi những thiếu sót. Kính mong hội đồng chấm sáng kiến kinh nghiệm xem xét để bản thân hoàn thiện và vận dụng vào quá trình công tác.
	Tôi xin chân thành cảm ơn!		
Đăk Drô, ngày 30 tháng 03 năm 2020
	                                                                                  Người thực hiện
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